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Understanding Embedded - FPGAs (Field
Programmable Gate Array)

Embedded - FPGAs, or Field Programmable Gate Arrays,
are advanced integrated circuits that offer unparalleled
flexibility and performance for digital systems. Unlike
traditional fixed-function logic devices, FPGAs can be
programmed and reprogrammed to execute a wide array
of logical operations, enabling customized functionality
tailored to specific applications. This reprogrammability
allows developers to iterate designs quickly and implement
complex functions without the need for custom hardware.

Applications of Embedded - FPGAs

The versatility of Embedded - FPGAs makes them
indispensable in numerous fields. In telecommunications,
FPGAs are used for high-speed data processing and
network infrastructure. In the automotive industry, they
support advanced driver-assistance systems (ADAS) and
infotainment solutions. Consumer electronics benefit from
FPGAs in devices requiring high performance and
adaptability, such as smart TVs and gaming consoles.
Industrial automation relies on FPGAs for real-time control
and processing in machinery and robotics. Additionally,
FPGAs play a crucial role in aerospace and defense, where
their reliability and ability to handle complex algorithms
are essential.

Common Subcategories of Embedded -
FPGAs

Within the realm of Embedded - FPGAs, several
subcategories address different needs and applications.
General-purpose FPGAs are the most widely used, offering
a balance of performance and flexibility for a broad range
of applications. High-performance FPGAs are designed for
applications requiring exceptional speed and
computational power, such as data centers and high-
frequency trading systems. Low-power FPGAs cater to
battery-operated and portable devices where energy
efficiency is paramount. Lastly, automotive-grade FPGAs
meet the stringent standards of the automotive industry,
ensuring reliability and performance in vehicle systems.

Types of Embedded - FPGAs

Embedded - FPGAs can be classified into several types
based on their architecture and specific capabilities. SRAM-
based FPGAs are prevalent due to their high speed and
ability to support complex designs, making them suitable
for performance-critical applications. Flash-based FPGAs
offer non-volatile storage, retaining their configuration
without power and enabling faster start-up times. Antifuse-
based FPGAs provide a permanent, one-time
programmable solution, ensuring robust security and
reliability for critical systems. Each type of FPGA brings
distinct advantages, making the choice dependent on the
specific needs of the application.
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Number of Logic Elements/Cells 17000

Total RAM Bits 716800

Number of I/O 133

Number of Gates -

Voltage - Supply 1.14V ~ 1.26V

Mounting Type Surface Mount

Operating Temperature 0°C ~ 85°C (TJ)

Package / Case 256-BGA
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Features
 Higher Logic Density for Increased System 

Integration
• 17K to 149K LUTs
• 116 to 586 I/Os

 Embedded SERDES 
• 150 Mbps to 3.2 Gbps for Generic 8b10b, 10-bit 

SERDES, and 8-bit SERDES modes
• Data Rates 230 Mbps to 3.2 Gbps per channel 

for all other protocols
• Up to 16 channels per device: PCI Express, 

SONET/SDH, Ethernet (1GbE, SGMII, XAUI), 
CPRI, SMPTE 3G and Serial RapidIO

 sysDSP™
• Fully cascadable slice architecture
• 12 to 160 slices for high performance multiply 

and accumulate
• Powerful 54-bit ALU operations
• Time Division Multiplexing MAC Sharing
• Rounding and truncation
• Each slice supports

— Half 36x36, two 18x18 or four 9x9 multipliers
— Advanced 18x36 MAC and 18x18 Multiply-

Multiply-Accumulate (MMAC) operations
 Flexible Memory Resources

• Up to 6.85Mbits sysMEM™ Embedded Block 
RAM (EBR) 

• 36K to 303K bits distributed RAM
 sysCLOCK Analog PLLs and DLLs

• Two DLLs and up to ten PLLs per device
 Pre-Engineered Source Synchronous I/O

• DDR registers in I/O cells

• Dedicated read/write levelling functionality
• Dedicated gearing logic
• Source synchronous standards support

— ADC/DAC, 7:1 LVDS, XGMII
— High Speed ADC/DAC devices

• Dedicated DDR/DDR2/DDR3 memory with DQS 
support

• Optional Inter-Symbol Interference (ISI) 
correction on outputs

 Programmable sysI/O™ Buffer Supports 
Wide Range of Interfaces

• On-chip termination
• Optional equalization filter on inputs
• LVTTL and LVCMOS 33/25/18/15/12
• SSTL 33/25/18/15 I, II
• HSTL15 I and HSTL18 I, II
• PCI and Differential HSTL, SSTL
• LVDS, Bus-LVDS, LVPECL, RSDS, MLVDS

 Flexible Device Configuration 
• Dedicated bank for configuration I/Os
• SPI boot flash interface
• Dual-boot images supported
• Slave SPI
• TransFR™ I/O for simple field updates
• Soft Error Detect embedded macro

 System Level Support
• IEEE 1149.1 and IEEE 1532 compliant
• Reveal Logic Analyzer
• ORCAstra FPGA configuration utility
• On-chip oscillator for initialization & general use
• 1.2 V core power supply

Table 1-1. LatticeECP3™ Family Selection Guide
Device ECP3-17 ECP3-35 ECP3-70 ECP3-95 ECP3-150

LUTs (K) 17 33 67 92 149
sysMEM Blocks (18 Kbits) 38 72 240 240 372
Embedded Memory (Kbits) 700 1327 4420 4420 6850
Distributed RAM Bits (Kbits) 36 68 145 188 303
18 x 18 Multipliers 24 64 128 128 320
SERDES (Quad) 1 1 3 3 4
PLLs/DLLs 2 / 2 4 / 2 10 / 2 10 / 2 10 / 2
Packages and SERDES Channels/ I/O Combinations
328 csBGA (10 x 10 mm) 2 / 116
256 ftBGA (17 x 17 mm) 4 / 133 4 / 133   
484 fpBGA (23 x 23 mm) 4 / 222 4 / 295 4 / 295 4 / 295  
672 fpBGA (27 x 27 mm) 4 / 310 8 / 380 8 / 380 8 / 380
1156 fpBGA (35 x 35 mm)   12 / 490 12 / 490 16 / 586

LatticeECP3 Family Data Sheet
Introduction
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Figure 2-2. PFU Diagram

Slice 
Slice 0 through Slice 2 contain two LUT4s feeding two registers, whereas Slice 3 contains two LUT4s only. For 
PFUs, Slice 0 through Slice 2 can be configured as distributed memory, a capability not available in the PFF. 
Table 2-1 shows the capability of the slices in both PFF and PFU blocks along with the operation modes they 
enable. In addition, each PFU contains logic that allows the LUTs to be combined to perform functions such as 
LUT5, LUT6, LUT7 and LUT8. There is control logic to perform set/reset functions (programmable as synchronous/
asynchronous), clock select, chip-select and wider RAM/ROM functions. 

Table 2-1. Resources and Modes Available per Slice

Figure 2-3 shows an overview of the internal logic of the slice. The registers in the slice can be configured for posi-
tive/negative and edge triggered or level sensitive clocks.

Slices 0, 1 and 2 have 14 input signals: 13 signals from routing and one from the carry-chain (from the adjacent 
slice or PFU). There are seven outputs: six to routing and one to carry-chain (to the adjacent PFU). Slice 3 has 10 
input signals from routing and four signals to routing. Table 2-2 lists the signals associated with Slice 0 to Slice 2.

Slice

PFU BLock PFF Block

Resources Modes Resources Modes

Slice 0 2 LUT4s and 2 Registers Logic, Ripple, RAM, ROM 2 LUT4s and 2 Registers Logic, Ripple, ROM

Slice 1 2 LUT4s and 2 Registers Logic, Ripple, RAM, ROM 2 LUT4s and 2 Registers Logic, Ripple, ROM

Slice 2 2 LUT4s and 2 Registers Logic, Ripple, RAM, ROM 2 LUT4s and 2 Registers Logic, Ripple, ROM

Slice 3 2 LUT4s Logic, ROM 2 LUT4s Logic, ROM

Slice 0

LUT4 &
CARRY

LUT4 &
CARRY

D D

Slice 1

LUT4 &
CARRY

LUT4 &
CARRY

Slice 2

LUT4 &
CARRY

LUT4 &
CARRY

From
 Routing

To
 Routing

Slice 3

LUT4 LUT4

D D D D

FF FF FF FF FF FF
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Figure 2-3. Slice Diagram

Table 2-2. Slice Signal Descriptions

Function Type Signal Names Description 

Input Data signal A0, B0, C0, D0 Inputs to LUT4 

Input Data signal A1, B1, C1, D1 Inputs to LUT4 

Input Multi-purpose M0 Multipurpose Input 

Input Multi-purpose M1 Multipurpose Input 

Input Control signal CE Clock Enable 

Input Control signal LSR Local Set/Reset 

Input Control signal CLK System Clock 

Input Inter-PFU signal FC Fast Carry-in1 

Input Inter-slice signal FXA Intermediate signal to generate LUT6 and LUT7

Input Inter-slice signal FXB Intermediate signal to generate LUT6 and LUT7

Output Data signals F0, F1 LUT4 output register bypass signals 

Output Data signals Q0, Q1 Register outputs 

Output Data signals OFX0 Output of a LUT5 MUX 

Output Data signals OFX1 Output of a LUT6, LUT7, LUT82 MUX depending on the slice 

Output Inter-PFU signal FCO Slice 2 of each PFU is the fast carry chain output1

1. See Figure 2-3 for connection details. 
2. Requires two PFUs. 

LUT4 &
CARRY*

SLICE

FF*

OFX0

F0

Q0

CI

CO

LUT4 &
CARRY*

CI

CO

FF*

OFX1

F1

Q1

F/SUM

F/SUM D

D

FCI From Different Slice/PFU

FCO To Different Slice/PFU

LUT5
MuxFrom

Routing

To
Routing

For Slices 0 and 1, memory control signals are generated from Slice 2 as follows:
         WCK is CLK
         WRE is from LSR
         DI[3:2] for Slice 1 and DI[1:0] for Slice 0 data from Slice 2
         WAD [A:D] is a 4-bit address from slice 2 LUT input

* Not in Slice 3

A0

C0
D0

A1
B1
C1
D1

CE
CLK
LSR

M1
M0

FXB
FXA

B0



2-14

Architecture
LatticeECP3 Family Data Sheet

Secondary Clock/Control Sources 
LatticeECP3 devices derive eight secondary clock sources (SC0 through SC7) from six dedicated clock input pads 
and the rest from routing. Figure 2-14 shows the secondary clock sources. All eight secondary clock sources are 
defined as inputs to a per-region mux SC0-SC7. SC0-SC3 are primary for control signals (CE and/or LSR), and 
SC4-SC7 are for the clock.

In an actual implementation, there is some overlap to maximize routability. In addition to SC0-SC3, SC7 is also an 
input to the control signals (LSR or CE). SC0-SC2 are also inputs to clocks along with SC4-SC7.

Figure 2-14. Secondary Clock Sources

Secondary Clock/Control Routing
Global secondary clock is a secondary clock that is distributed to all regions. The purpose of the secondary clock 
routing is to distribute the secondary clock sources to the secondary clock regions. Secondary clocks in the 
LatticeECP3 devices are region-based resources. Certain EBR rows and special vertical routing channels bind the 
secondary clock regions. This special vertical routing channel aligns with either the left edge of the center DSP 
slice in the DSP row or the center of the DSP row. Figure 2-15 shows this special vertical routing channel and the 
20 secondary clock regions for the LatticeECP3 family of devices. All devices in the LatticeECP3 family have eight 
secondary clock resources per region (SC0 to SC7). The same secondary clock routing can be used for control 
signals. 

Secondary Clock Sources

From Routing

From 
Routing

From 
Routing

From 
Routing

From 
Routing

From 
Routing

From 
Routing

From 
Routing

From 
Routing

From Routing

Clock Input

Clock
Input

Clock
Input

Clock Input

From Routing

From Routing

Note: Clock inputs can be configured in differential or single-ended mode.

From Routing

From Routing

Clock Input

Clock Input

From Routing

From Routing
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For further information, please refer to TN1182, LatticeECP3 sysDSP Usage Guide.

MULT DSP Element
This multiplier element implements a multiply with no addition or accumulator nodes. The two operands, AA and 
AB, are multiplied and the result is available at the output. The user can enable the input/output and pipeline regis-
ters. Figure 2-26 shows the MULT sysDSP element.

Figure 2-26. MULT sysDSP Element

R= A ± B ± C
R = Logic (B, C)

AA AB BA BB

MULTA MULTB

BMUXAMUX

C
M

U
X

ALU

A_ALU B_ALU

IR

PRPR

OR

Rounding
A_ALU
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CIN COUT
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0

0 0

From FPGA Core
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OROR FR

  ==

PR
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www.latticesemi.com/dynamic/view_document.cfm?document_id=32322
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MAC DSP Element
In this case, the two operands, AA and AB, are multiplied and the result is added with the previous accumulated 
value. This accumulated value is available at the output. The user can enable the input and pipeline registers, but 
the output register is always enabled. The output register is used to store the accumulated value. The ALU is con-
figured as the accumulator in the sysDSP slice in the LatticeECP3 family can be initialized dynamically. A regis-
tered overflow signal is also available. The overflow conditions are provided later in this document. Figure 2-27 
shows the MAC sysDSP element.

Figure 2-27. MAC DSP Element

R= A ± B ± C
R = Logic (B, C)
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Two adjacent PIOs can be joined to provide a differential I/O pair (labeled as “T” and “C”) as shown in Figure 2-32. 
The PAD Labels “T” and “C” distinguish the two PIOs. Approximately 50% of the PIO pairs on the left and right 
edges of the device can be configured as true LVDS outputs. All I/O pairs can operate as LVDS inputs. 

Table 2-11. PIO Signal List 

PIO 
The PIO contains four blocks: an input register block, output register block, tristate register block and a control logic 
block. These blocks contain registers for operating in a variety of modes along with the necessary clock and selec-
tion logic.

Input Register Block 
The input register blocks for the PIOs, in the left, right and top edges, contain delay elements and registers that can 
be used to condition high-speed interface signals, such as DDR memory interfaces and source synchronous inter-
faces, before they are passed to the device core. Figure 2-33 shows the input register block for the left, right and 
top edges. The input register block for the bottom edge contains one element to register the input signal and no 
DDR registers. The following description applies to the input register block for PIOs in the left, right and top edges 
only.

Name Type Description

INDD Input Data Register bypassed input. This is not the same port as INCK.

IPA, INA, IPB, INB Input Data Ports to core for input data

OPOSA, ONEGA1, 
OPOSB, ONEGB1

Output Data Output signals from core. An exception is the ONEGB port, used for tristate logic 
at the DQS pad.

CE PIO Control Clock enables for input and output block flip-flops.

SCLK PIO Control System Clock (PCLK) for input and output/TS blocks. Connected from clock ISB.

LSR PIO Control Local Set/Reset

ECLK1, ECLK2 PIO Control Edge clock sources. Entire PIO selects one of two sources using mux.

ECLKDQSR1 Read Control From DQS_STROBE, shifted strobe for memory interfaces only.

DDRCLKPOL1 Read Control Ensures transfer from DQS domain to SCLK domain.

DDRLAT1 Read Control Used to guarantee INDDRX2 gearing by selectively enabling a D-Flip-Flop in dat-
apath.

DEL[3:0] Read Control Dynamic input delay control bits.

INCK To Clock Distribution 
and PLL

PIO treated as clock PIO, path to distribute to primary clocks and PLL.

TS Tristate Data Tristate signal from core (SDR)

DQCLK01, DQCLK11 Write Control Two clocks edges, 90 degrees out of phase, used in output gearing.

DQSW2 Write Control Used for output and tristate logic at DQS only.

DYNDEL[7:0] Write Control Shifting of write clocks for specific DQS group, using 6:0 each step is approxi-
mately 25ps, 128 steps. Bit 7 is an invert (timing depends on input frequency). 
There is also a static control for this 8-bit setting, enabled with a memory cell.

DCNTL[6:0] PIO Control Original delay code from DDR DLL

DATAVALID1 Output Data Status flag from DATAVALID logic, used to indicate when input data is captured in 
IOLOGIC and valid to core.

READ For DQS_Strobe Read signal for DDR memory interface

DQSI For DQS_Strobe Unshifted DQS strobe from input pad

PRMBDET For DQS_Strobe DQSI biased to go high when DQSI is tristate, goes to input logic block as well as 
core logic.

GSRN Control from routing Global Set/Reset

1. Signals available on left/right/top edges only.
2. Selected PIO.
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Figure 2-40. SERDES/PCS Quads (LatticeECP3-150)

Table 2-13. LatticeECP3 SERDES Standard Support

Standard
Data Rate 

(Mbps)
Number of 

General/Link Width Encoding Style

PCI Express 1.1 2500 x1, x2, x4 8b10b

Gigabit Ethernet 1250, 2500 x1 8b10b

SGMII 1250 x1 8b10b

XAUI 3125 x4 8b10b

Serial RapidIO Type I,
Serial RapidIO Type II,
Serial RapidIO Type III

1250,
2500,
3125

x1, x4 8b10b

CPRI-1,
CPRI-2,
CPRI-3,
CPRI-4

614.4,
1228.8,
2457.6,
3072.0

x1 8b10b

SD-SDI
(259M, 344M)

1431,
1771, 
270,
360,
540

x1 NRZI/Scrambled

HD-SDI
(292M)

1483.5,
1485 x1 NRZI/Scrambled

3G-SDI
(424M)

2967,
2970 x1 NRZI/Scrambled

SONET-STS-32 155.52 x1 N/A

SONET-STS-122 622.08 x1 N/A

SONET-STS-482 2488 x1 N/A

1. For slower rates, the SERDES are bypassed and CML signals are directly connected to the FPGA routing.
2. The SONET protocol is supported in 8-bit SERDES mode. See TN1176 Lattice ECP3 SERDES/PCS Usage Guide for more information.
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Table 2-16. Selectable Master Clock (MCCLK) Frequencies During Configuration (Nominal)

Density Shifting 
The LatticeECP3 family is designed to ensure that different density devices in the same family and in the same 
package have the same pinout. Furthermore, the architecture ensures a high success rate when performing design 
migration from lower density devices to higher density devices. In many cases, it is also possible to shift a lower uti-
lization design targeted for a high-density device to a lower density device. However, the exact details of the final 
resource utilization will impact the likelihood of success in each case. An example is that some user I/Os may 
become No Connects in smaller devices in the same package. Refer to the LatticeECP3 Pin Migration Tables and 
Diamond software for specific restrictions and limitations.

MCCLK (MHz) MCCLK (MHz) 

10

2.51 13

4.3 152

5.4 20

6.9 26

8.1 333

9.2

1. Software default MCCLK frequency. Hardware default is 3.1 MHz.
2. Maximum MCCLK with encryption enabled.
3. Maximum MCCLK without encryption.

http://www.latticesemi.com/dynamic/index.cfm?fuseaction=view_documents&document_type=32&sloc=01-01-00-10
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DC Electrical Characteristics
Over Recommended Operating Conditions

Symbol Parameter Condition Min. Typ. Max. Units

IIL, IIH
1, 4 Input or I/O Low Leakage 0  VIN  (VCCIO - 0.2 V) — — 10 µA

IIH
1, 3 Input or I/O High Leakage (VCCIO - 0.2 V) < VIN  3.6 V — — 150 µA

IPU I/O Active Pull-up Current 0  VIN  0.7 VCCIO –30 — –210 µA

IPD I/O Active Pull-down Current VIL (MAX)  VIN  VCCIO 30 — 210 µA

IBHLS Bus Hold Low Sustaining Current VIN = VIL (MAX) 30 — — µA

IBHHS Bus Hold High Sustaining Current VIN = 0.7 VCCIO –30 — — µA

IBHLO Bus Hold Low Overdrive Current 0  VIN  VCCIO — — 210 µA

IBHHO Bus Hold High Overdrive Current 0  VIN  VCCIO — — –210 µA

VBHT Bus Hold Trip Points 0  VIN  VIH (MAX) VIL (MAX) — VIH (MIN) V

C1 I/O Capacitance2 VCCIO = 3.3 V, 2.5 V, 1.8 V, 1.5 V, 1.2 V, 
VCC = 1.2 V, VIO = 0 to VIH (MAX) 

— 5 8 pf

C2 Dedicated Input Capacitance2 VCCIO = 3.3 V, 2.5 V, 1.8 V, 1.5 V, 1.2 V, 
VCC = 1.2 V, VIO = 0 to VIH (MAX) 

— 5 7 pf

1. Input or I/O leakage current is measured with the pin configured as an input or as an I/O with the output driver tri-stated. It is not measured 
with the output driver active. Bus maintenance circuits are disabled. 

2. TA 25 oC, f = 1.0 MHz.
3. Applicable to general purpose I/Os in top and bottom banks.
4. When used as VREF, maximum leakage= 25 µA.
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sysI/O Single-Ended DC Electrical Characteristics

Input/Output 
Standard

VIL VIH  VOL
Max. (V)

VOH
Min. (V) IOL

1 (mA) IOH
1 (mA)Min. (V) Max. (V) Min. (V) Max. (V)

LVCMOS33 –0.3 0.8 2.0 3.6
0.4 VCCIO - 0.4 20, 16, 

12, 8, 4
–20, –16, 

–12, -8, –4

0.2 VCCIO - 0.2 0.1 –0.1

LVCMOS25 –0.3 0.7 1.7 3.6
0.4 VCCIO - 0.4 20, 16, 

12, 8, 4
–20, –16, 

–12, –8, –4

0.2 VCCIO - 0.2 0.1 –0.1

LVCMOS18 –0.3 0.35 VCCIO 0.65 VCCIO 3.6
0.4 VCCIO - 0.4 16, 12, 

8, 4
–16, –12,

–8, –4

0.2 VCCIO - 0.2 0.1 –0.1

LVCMOS15 –0.3 0.35 VCCIO 0.65 VCCIO 3.6
0.4 VCCIO - 0.4 8, 4 –8, –4

0.2 VCCIO - 0.2 0.1 –0.1

LVCMOS12 –0.3 0.35 VCC 0.65 VCC 3.6
0.4 VCCIO - 0.4 6, 2 –6, –2

0.2 VCCIO - 0.2 0.1 –0.1

LVTTL33 –0.3 0.8 2.0 3.6
0.4 VCCIO - 0.4 20, 16, 

12, 8, 4
–20, –16, 

–12, –8, –4

0.2 VCCIO - 0.2 0.1 –0.1

PCI33 –0.3 0.3 VCCIO 0.5 VCCIO 3.6 0.1 VCCIO 0.9 VCCIO 1.5 –0.5

SSTL18_I –0.3 VREF - 0.125 VREF + 0.125 3.6 0.4 VCCIO - 0.4 6.7 –6.7

SSTL18_II
(DDR2 Memory) –0.3 VREF - 0.125 VREF + 0.125 3.6 0.28 VCCIO - 0.28

8 –8

11 –11

SSTL2_I –0.3 VREF - 0.18 VREF + 0.18 3.6 0.54 VCCIO - 0.62
7.6 –7.6

12 –12

SSTL2_II
(DDR Memory) –0.3 VREF - 0.18 VREF + 0.18 3.6 0.35 VCCIO - 0.43

15.2 –15.2

20 –20

SSTL3_I –0.3 VREF - 0.2 VREF + 0.2 3.6 0.7 VCCIO - 1.1 8 –8

SSTL3_II –0.3 VREF - 0.2 VREF + 0.2 3.6 0.5 VCCIO - 0.9 16 –16

SSTL15 
(DDR3 Memory) –0.3 VREF - 0.1 VREF + 0.1 3.6 0.3

VCCIO - 0.3 7.5 –7.5

VCCIO * 0.8 9 –9

HSTL15_I –0.3 VREF - 0.1 VREF + 0.1 3.6 0.4 VCCIO - 0.4
4 –4

8 –8

HSTL18_I –0.3 VREF - 0.1 VREF + 0.1 3.6 0.4 VCCIO - 0.4
8 –8

12 –12

HSTL18_II –0.3 VREF - 0.1 VREF + 0.1 3.6 0.4 VCCIO - 0.4 16 –16

1. For electromigration, the average DC current drawn by I/O pads between two consecutive VCCIO or GND pad connections, or between the 
last VCCIO or GND in an I/O bank and the end of an I/O bank, as shown in the Logic Signal Connections table (also shown as I/O grouping) 
shall not exceed n * 8 mA, where n is the number of I/O pads between the two consecutive bank VCCIO or GND connections or between the 
last VCCIO and GND in a bank and the end of a bank. IO Grouping can be found in the Data Sheet Pin Tables, which can also be generated 
from the Lattice Diamond software.
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Figure 3-16. Jitter Transfer – 1.25 Gbps

Figure 3-17. Jitter Transfer – 622 Mbps
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PCI Express Electrical and Timing Characteristics 
AC and DC Characteristics

Over Recommended Operating Conditions

Symbol Description Test Conditions Min Typ Max Units

Transmit1

UI Unit interval 399.88 400 400.12 ps

VTX-DIFF_P-P Differential peak-to-peak output voltage 0.8 1.0 1.2 V

VTX-DE-RATIO
De-emphasis differential output voltage 
ratio –3 –3.5 -4 dB

VTX-CM-AC_P
RMS AC peak common-mode output 
voltage — — 20 mV

VTX-RCV-DETECT
Amount of voltage change allowed dur-
ing receiver detection — — 600 mV

VTX-DC-CM Tx DC common mode voltage 0 — VCCOB + 5% V

ITX-SHORT Output short circuit current VTX-D+=0.0 V
VTX-D-=0.0 V — — 90 mA

ZTX-DIFF-DC Differential output impedance 80 100 120 Ohms

RLTX-DIFF Differential return loss 10 — — dB

RLTX-CM Common mode return loss 6.0 — — dB

TTX-RISE Tx output rise time 20 to 80% 0.125 — — UI

TTX-FALL Tx output fall time 20 to 80% 0.125 — — UI

LTX-SKEW
Lane-to-lane static output skew for all 
lanes in port/link — — 1.3 ns

TTX-EYE Transmitter eye width 0.75 — — UI

TTX-EYE-MEDIAN-TO-MAX-JITTER
Maximum time between jitter median 
and maximum deviation from median — — 0.125 UI

Receive1, 2

UI Unit Interval 399.88 400 400.12 ps

VRX-DIFF_P-P Differential peak-to-peak input voltage 0.343 — 1.2 V

VRX-IDLE-DET-DIFF_P-P Idle detect threshold voltage 65 — 3403 mV

VRX-CM-AC_P
Receiver common mode voltage for AC 
coupling — — 150 mV

ZRX-DIFF-DC DC differential input impedance 80 100 120 Ohms

ZRX-DC DC input impedance 40 50 60 Ohms

ZRX-HIGH-IMP-DC Power-down DC input impedance 200K — — Ohms

RLRX-DIFF Differential return loss 10 — — dB

RLRX-CM Common mode return loss 6.0 — — dB

TRX-IDLE-DET-DIFF-ENTERTIME

Maximum time required for receiver to 
recognize and signal an unexpected idle 
on link

— — — ms

1. Values are measured at 2.5 Gbps.
2. Measured with external AC-coupling on the receiver.
3.Not in compliance with PCI Express 1.1 standard.
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Figure 3-18. XAUI Sinusoidal Jitter Tolerance Mask

Note: The sinusoidal jitter tolerance is measured with at least 0.37 UIpp of Deterministic
jitter (Dj) and the sum of Dj and Rj (random jitter) is at least 0.55 UIpp. Therefore, the 
sum of Dj, Rj and Sj (sinusoidal jitter) is at least 0.65 UIpp (Dj = 0.37, Rj = 0.18, Sj = 0.1).
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JTAG Port Timing Specifications
Over Recommended Operating Conditions

Figure 3-32. JTAG Port Timing Waveforms

Symbol Parameter Min Max Units

fMAX TCK clock frequency — 25 MHz

tBTCP TCK [BSCAN] clock pulse width 40 — ns

tBTCPH TCK [BSCAN] clock pulse width high 20 — ns

tBTCPL TCK [BSCAN] clock pulse width low 20 — ns

tBTS TCK [BSCAN] setup time 10 — ns

tBTH TCK [BSCAN] hold time 8 — ns

tBTRF TCK [BSCAN] rise/fall time 50 — mV/ns

tBTCO TAP controller falling edge of clock to valid output — 10 ns

tBTCODIS TAP controller falling edge of clock to valid disable — 10 ns

tBTCOEN TAP controller falling edge of clock to valid enable — 10 ns

tBTCRS BSCAN test capture register setup time 8 — ns

tBTCRH BSCAN test capture register hold time 25 — ns

tBUTCO BSCAN test update register, falling edge of clock to valid output — 25 ns

tBTUODIS BSCAN test update register, falling edge of clock to valid disable — 25 ns

tBTUPOEN BSCAN test update register, falling edge of clock to valid enable — 25 ns

TMS

TDI

TCK

TDO

Data to be
captured
from I/O

Data to be
driven out

to I/O

ataD dilaVataD dilaV

ataD dilaVataD dilaV
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tBTCPH tBTCPL
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tBTS tBTH

tBTCP
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D7/SPID0 I/O Parallel configuration I/O. SPI/SPIm data input. Open drain during configura-
tion.

DI/CSSPI0N/CEN I/O Serial data input for slave serial mode. SPI/SPIm mode chip select. 

Dedicated SERDES Signals3

PCS[Index]_HDINNm I High-speed input, negative channel m 

PCS[Index]_HDOUTNm O High-speed output, negative channel m 

PCS[Index]_REFCLKN I Negative Reference Clock Input 

PCS[Index]_HDINPm I High-speed input, positive channel m 

PCS[Index]_HDOUTPm O High-speed output, positive channel m 

PCS[Index]_REFCLKP I Positive Reference Clock Input 

PCS[Index]_VCCOBm — Output buffer power supply, channel m (1.2V/1.5)

PCS[Index]_VCCIBm — Input buffer power supply, channel m (1.2V/1.5V) 

1. When placing switching I/Os around these critical pins that are designed to supply the device with the proper reference or supply voltage, 
care must be given. 

2. These pins are dedicated inputs or can be used as general purpose I/O.
3. m defines the associated channel in the quad. 

Signal Descriptions (Cont.)
Signal Name I/O Description 
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Package Pinout Information
Package pinout information can be found under “Data Sheets” on the LatticeECP3 product pages on the Lattice 
website at http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3 and in the Diamond or ispLEVER 
software tools. To create pinout information from within ispLEVER Design Planner, select Tools > Spreadsheet 
View. Then select Select File > Export and choose a type of output file. To create a pin information file from within 
Diamond select Tools > Spreadsheet View or Tools >Package View; then, select File > Export and choose a 
type of output file. See Diamond or ispLEVER Help for more information.

Thermal Management 
Thermal management is recommended as part of any sound FPGA design methodology. To assess the thermal 
characteristics of a system, Lattice specifies a maximum allowable junction temperature in all device data sheets. 
Designers must complete a thermal analysis of their specific design to ensure that the device and package do not 
exceed the junction temperature limits. Refer to the Thermal Management document to find the device/package 
specific thermal values.

For Further Information
For further information regarding Thermal Management, refer to the following:

• Thermal Management document

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• Power Calculator tool included with the Diamond and ispLEVER design tools, or as a standalone download from 
www.latticesemi.com/software

http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3.aspx
www.latticesemi.com/dynamic/view_document.cfm?document_id=210
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
http://www.latticesemi.com/products/designsoftware/index.cfm
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LatticeECP3 Part Number Description

LFE3 – XXX XX – X X XXXXXX  X

Grade
    C = Commercial
    I = Industrial    Logic Capacity

     17 = 17K LUTs
     35 = 33K LUTs
     70 = 67K LUTs
     95 = 92K LUTs
    150 = 149K LUTs
     Supply Voltage
     EA = 1.2 V

Speed
     6 = Slowest
     7
     8 = Fastest for LatticeECP3-17EA

1. Green = Halogen free and lead free.

Power
     Blank = Standard Power
     L = Low Power 

Package
    FTN256 = 256-ball Lead-Free ftBGA
    FN484 = 484-ball Lead-Free fpBGA
    FN672 = 672-ball Lead-Free fpBGA
    FN1156 = 1156-ball Lead-Free fpBGA
    MG328 = 328-ball Green csBGA1

Device Family
    ECP3 (LatticeECP3 FPGA + SERDES)
 

Ordering Information
LatticeECP3 devices have top-side markings, for commercial and industrial grades, as shown below:

Note: See PCN 05A-12 for information regarding a change to the top-side mark logo.

LFE3-95EA
7FN672C
Datecode

LFE3-95EA
7FN672I
Datecode

Commercial Industrial

LatticeECP3 Family Data Sheet
Ordering Information

http://www.latticesemi.com/documents/doc44912x28.pdf
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For Further Information
A variety of technical notes for the LatticeECP3 family are available on the Lattice website at www.latticesemi.com.

• TN1169, LatticeECP3 sysCONFIG Usage Guide

• TN1176, LatticeECP3 SERDES/PCS Usage Guide

• TN1177, LatticeECP3 sysIO Usage Guide

• TN1178, LatticeECP3 sysCLOCK PLL/DLL Design and Usage Guide

• TN1179, LatticeECP3 Memory Usage Guide

• TN1180, LatticeECP3 High-Speed I/O Interface

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• TN1182, LatticeECP3 sysDSP Usage Guide

• TN1184, LatticeECP3 Soft Error Detection (SED) Usage Guide

• TN1189, LatticeECP3 Hardware Checklist 

• TN1215, LatticeECP2MS and LatticeECP2S Devices 

• TN1216, LatticeECP2/M and LatticeECP3 Dual Boot Feature Advanced Security Encryption Key Program-
ming Guide for LatticeECP3

• TN1222, LatticeECP3 Slave SPI Port User's Guide

For further information on interface standards refer to the following websites:

• JEDEC Standards (LVTTL, LVCMOS, SSTL, HSTL): www.jedec.org
• PCI: www.pcisig.com

LatticeECP3 Family Data Sheet
Supplemental Information

www.latticesemi.com/~/media/Documents/ApplicationNotes/AD/AdvancedSecurityEncryptionKeyProgrammingGuideforLatticeECP3LatticeECP2MSandLatticeECP2SDevices.PDF
www.latticesemi.com/~/media/Documents/ApplicationNotes/L/AM/LatticeECP2MandLatticeECP3DualBootFeature.PDF
www.latticesemi.com/~/media/Documents/ApplicationNotes/L/AM/LatticeECP2MandLatticeECP3DualBootFeature.PDF
www.latticesemi.com/dynamic/view_document.cfm?document_id=32318
www.latticesemi.com/dynamic/view_document.cfm?document_id=32319
www.latticesemi.com/dynamic/view_document.cfm?document_id=32320
www.latticesemi.com/dynamic/view_document.cfm?document_id=32317
www.latticesemi.com/dynamic/view_document.cfm?document_id=32322
www.latticesemi.com/dynamic/view_document.cfm?document_id=32323
www.latticesemi.com/dynamic/view_document.cfm?document_id=32324
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
www.latticesemi.com/~/media/Documents/ApplicationNotes/L/AM/LatticeECP3SlaveSPIPortUsersGuide.pdf
www.pcisig.com
www.latticesemi.com/dynamic/view_document.cfm?document_id=32314
www.latticesemi.com/dynamic/view_document.cfm?document_id=32316
www.jedec.org
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Updated Simplified Channel Block Diagram for SERDES/PCS Block 
diagram.

Updated Device Configuration text section.

Corrected software default value of MCCLK to be 2.5 MHz.

DC and Switching 
Characteristics

Updated VCCOB Min/Max data in Recommended Operating Conditions 
table.

Corrected footnote 2 in sysIO Recommended Operating Conditions 
table.

Added added footnote 7 for tSKEW_PRIB to External Switching Charac-
teristics table. 

Added 2-to-1 Gearing text section and table.

Updated External Reference Clock Specification (refclkp/refclkn) table.

LatticeECP3 sysCONFIG Port Timing Specifications - updated tDINIT 
information.

Added sysCONFIG Port Timing waveform.

Serial Input Data Specifications table, delete Typ data for VRX-DIFF-S.

Added footnote 4 to sysCLOCK PLL Timing table for tPFD.

Added SERDES/PCS Block Latency Breakdown table.

External Reference Clock Specifications table, added footnote 4, add 
symbol name vREF-IN-DIFF.

Added SERDES External Reference Clock Waveforms.

Updated Serial Output Timing and Levels table.

Pin-to-pin performance table, changed "typically 3% slower" to "typically 
slower".

Updated timing information

Updated SERDES minimum frequency.

Added data to the following tables: External Switching Characteristics, 
Internal Switching Characteristics, Family Timing Adders, Maximum I/O 
Buffer Speed, DLL Timing, High Speed Data Transmitter, Channel Out-
put Jitter, Typical Building Block Function Performance, Register-to-
Register Performance, and Power Supply Requirements.

Updated Serial Input Data Specifications table.

Updated Transmit table, Serial Rapid I/O Type 2 Electrical and Timing 
Characteristics section.

Pinout Information Updated Signal Description tables.

Updated Pin Information Summary tables and added footnote 1.

February 2009 01.0 — Initial release.

Date Version Section Change Summary


